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Preface

1. Scope of this manual:

This manual applies to the FCEN-8LKM-8A-Mmodule of ELCO.

The information in this manual enables you to run the FCEN-8LKM-8A-Mmodule on Profinet, CC-Link IE FieldBasic, Modbus-TCP and EtherNet/IP

as a distributed I/O device.

2. Basic knowledge requirements

This manual presumes a general knowledge in the field of automation engineering and describes the components based on the data valid at the

time of its release.

ELCO reserves the right of including a product information for each new component, and for each component of a later version.

3. Guide:

This manual introduces the hardware and usage of the FCEN-8LKM-8A-M module for the Profinet, EtherNet/IP, CC-Link IEFB and Modbus-TCP

protocol.Covered topics are:

 Installation and wiring

 Commissioning and diagnostics

 Components

 Article numbers

 Technical specifications

4. Technical support:

Please contact your local ELCO representative or call the hotline if you have any questions about the products described in this manual.

Additional information about ELCO products is available:

https://www.elcoautomation.com/en-us/

5. Disclaimer of liability:

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be

precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary

corrections are included in subsequent editions.

https://www.elcoautomation.com/en-us/
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1. Product overview

1.1 Introduction

The FCEN-8LKM-8A-M module supporting IO-Link function is a new type of distributed I/O system. As a multi protocol module, FCEN-8LKM-8A-M

allows users to select different protocols (Profinet, EtherNet/IP, CC-Link IEFB andModbus-TCP) for communication with PLC.

This series of products adopts a fully sealed design structure and can be directly installed in industrial sites, including harsh working environments

where liquids, dust, and vibrations may occur.

1.2 Applications

IO-Link is an IO communication technology from the controller to the lowest level of automation. Through the IO-Link master, information such as

sensors and actuators is transmitted to the controller via the fieldbus network so as to improve work efficiency and reduce production costs.

FCEN-8LKM-8A-Mmodule supporting IO-Link communication, as an IO-Link master, does not require a dedicated communication cable, and can

achieve efficient communication with IO-Link device through traditional non-shielded industrial cables. Each IO-Link master can support a maximum

of 8 IO-Link interfaces. It meets the requirements of IO-Link v1.1 and supports three transmission rate COM1 (4.8kbps), COM2 (38.4kbps), COM3

(230.4kbps). It can easily connect IO-Link sensors of various brands and other IO-Link devices, as well as sensors and actuators of ordinary switching

signals.

1.3 Features

 Up to IP67 protection class

 Designed with IO-Link v1.1.3 specification

 The IO-Link master supports three communication rates of COM1, 2 and 3

 Interface type Class-A or Class-B is optional

 Connects various IO-Link standard devices and standard switch signals

 LED status display, channel protection and diagnosis
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1.4 Type

..

No. Type Description

1 FCEN-8LKM-8A-M

Multi protocol IO-Link master module, supporting Profinet,

EtherNet/IP, CC-Link IEFB andModbus-TCP.

8 IO-Link interfaces (8*Class-A)

2 Male+Female,M12 L-Code power supply

2 Female, M12 D-Code field bus interface
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2. Technical characteristics

2.1 IO-Link master

Each FCEN-8LKM-8A-M module occupies an Profinet, EtherNet/IP, CC-Link IEFB andModbus-TCP address. Depending on the type, up to 8 IO-Link

devices can be connected. As an Profinet, EtherNet/IP, CC-Link IEFB andModbus-TCP slave, the FCEN-8LKM-8A-Mmodule can specify the device name

and the corresponding IP address through the configuration software, or it can automatically assign an IP address by the PLC according to the network

topology, thereby realizing the communication of the Profinet, EtherNet/IP, CC-Link IEFB andModbus-TCP network based on the industrial Ethernet

structure. The customer can set the IO-Link interface to the communication mode that meets the requirements of IO-Link v1.1.3 or the SIO mode used

as standard digital input and output in the programming software as required.

The IO-Link interface supports a total of three transmission rate: COM1 (4.8kbps), COM2 (38.4kbps)and COM3 (230.4kbps). The rate will be adaptive

according to the characteristics of the IO-Link device.

2.2 IO-Link sensor hub

The Compact67 series IO-Link signal hub can be used as an IO-Link device to connect with the IO-Link master of ELCO or other brands. It conforms to

the IO-Link v1.1.3 standard and supports COM2 (38.4 kbps) transmission rate. Each IO-Link interface of the IO-Link master module can be extended

with an IO-Link hub to collect input and output signals. That is, an 8-port IO-Link master plus 8 IO-Link hubs which can connect up to 128 digital

signals.

IO-Link signal hub has different types to choose from, there are products that support Class-A or Class-B standards, and also include two different

signal interface - M12 (A-Code, 2 digital or 1 analog are available) and M8 (3-pin, 1 digital is available).

2.3 IO-Link cable

According to the IO-Link protocol, point-to-point transmission is used between the IO-Link master and device. With the ordinary not shielded

industrial cables (such as sensor cables), an extended distance of 20 meters can be reached.

According to the IO-Link protocol standard, ordinary 3-core cables can meet transmission requirements, and the 4-core or 5-core cables are used for

specific functions. The Compact67 series IO-Link module needs to determine what kind of cable connection to use according to the interface type and

IO type of the IO-Link hub.

1) Class-A IO-Link interface, because only three pins are defined, the fourth pin (PIN2) can be used as auxiliary power supply, so input IO-Link hub can

use 3-core cable, output IO-Link hub requires a 4-core cable.

2) Class-B IO-Link interface, because all five pins are defined, when using this IO-Link hub to connect to the IO-Link master, a 5-core cable should be

used.
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2.4 Hardware
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2.5 LED indicator

The module's indicator can clearly indicate its operating status. For specific fault indications and solutions, please refer to Section 7.1 “LED Fault

Indicator”.

IO-Link master indicator

Module statusMOD

System power indicatorUs

EN_In network status LK1

EN_Out network status LK2

Bus comm. statusNET

Digital channel indicator B

IO-Link channel indicator A

Aux. power indicatorUa
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3. Installation and wiring

3.1 Installation dimensions
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3.2 Installation position and size

Thanks to IP67 high protection level and excellent resistance to vibration and interference, FCEN-8LKM-8A-M can be installed in almost any location.

FCEN-8LKM-8A-M uses a compact design to minimize installation space. Its IO-Link master module and IO-Link signal hub use standard dimensions.

The following table shows the module installation dimensions:

FCEN-8LKM-8A-M

Installation width 60mm

Installation height 230mm

Installation depth 32.6mm
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3.3 Wiring guidance

Please make sure to cut off power supply when wiring to ensure safety.

3.3.1 Connecting module to protective earth (PE)

 Always connect the module to protective earth.

 The module also requires this connection to protective earth in order to discharge any interference currents to ground, and for EMC

compatibility.

 Always make sure you have a low-impedance connection to protective earth.

3.3.2 Module power supply

FCEN-8LKM-8A-Mmodule adopts 24VDC power supply, and power IO-Link signal hub by extensible cable, voltage range 18~30VDC, standard M12

L-Code connector.

The power supply of IO-Link master is divided into two parts: System and sensor power supply Us (+24V, 0V), and auxiliary power supply Ua (P24,

N24). Us is used for module chips and input signal power supply, while Ua is used for output signal power supply.

For FCEN-8LKM-8A-M, the two power supply are partially isolated, electrical isolation between Us+ and Ua+, and internally connected between Us-

and Ua-.

1）Power in connector (Male)
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2）Power out connector (Female)

3）Power definition

Terminal Function Power supply

1 System and input power supply Us+ 24V

2 Output power supply Ua- 0V

3 System and input power supply Us- 0V

4 Output power supply Ua+ 24V

5 Function earth FE
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3.3.3 Module Bus connection

FCEN-8LKM-8A-Mmodule, supporting Profinet or EtherNet/IP protocol, transmits signals by a shielded cable, M12 D-Code connector.

1）BUS-In (Female)

2）BUS-Out (Female)

3）Bus definition

Terminal Function Cable color

1 Transmit Data (TD+) Yellow

2 Receive Data(RD+) White

3 Transmit Data(TD-) Orange

4 Receive Data(RD-) Blue
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3.3.4 IO-Link master port cable connection

All Compact67 series IO-Link masters are connected through a standard 5-pin M12 connector. Each M12 port can be connected to a maximum of 1

IO-Link signal or 2 switching signals (input or output).

1) IO-Link port connector (Female)

2) IO-Link port pin definition

Terminal Class-A

1 Power supply 24V+

2 Signal input/output B

3 Power supply GND

4 IO-Link/input A

5 Function earth FE

3) The power supply (Pin1 and Pin3) and signal input power supply come from the system power supply Us, and signal output power supply

(Pin2) come from the auxiliary power supply Ua.

Note: When the master station of Class-A interface is used to connect LKHA series slaves, the output of Pin2 (i.e. signal B) can be controlled

by program to meet the output power supply of LKHA slaves.
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3.4 Setting protocols of the module

The multi protocol technology allows you to use the same module in different field bus systems. The FCEN-8LKM-8A-M module supports both Profinet,

EtherNet/IP, CC-Link IEFB andModbus-TCP, users can easily switch them.

The FCEN-8LKM-8A-M module can set the protocol and network parameters (such as IP address, subnet mask, etc.) through its built-in rotary code

switch. The module will read the status of the switch and update the corresponding network parameter operation mode when re-powered on.

Note: Please operate the rotary code switch when the module is powered off, and it will take effect when powered on again.

The following table describes the protocol selection by the rotary switch settings:

Protocol x100 x10 x1

EtherNet/IP 0-2 0-9 0-9

Profinet 3 0-9 0-9

CC-LinkIEFB 4-6 0-9 0-9

ModbusTCP 7 0-9 0-9

The factory default setting of the rotary switch is 300, that means it works as a Profinet slave. You can change the protocol to EtherNet/IP by setting

the rotary switch to 000~299. You can also change the protocol to CC-Link IEFB by setting the rotary switch to 400~699. If you want to do this, you

must turn off the power supply of the module first. After you finish the setting of rotary switch, power on the module again and the module will

start the switching process. The LED next to the rotary switch will flash yellow and the indicators of IO-Link port will turn red. The protocol switching

will be finished after about 30 seconds. The LED indicator next to the rotary switch and the LED indicators of IO-Link port will turn off. Then you have

finish the protocol switching progress after the power recycled.

If you want to change the protocol back to Profinet. You need to repeat the process above with setting rotary switch to 300-399.
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4. EtherNet/IP

4.1 Setting the network parameters

When the FCEN-8LKM-8A-Mmodule powered on, the module will read the rotary switch positions. If the rotary switch position stays 000~299, the

module will work in EtherNet/IP protocol.

The module supports the DHCP and BOOTP protocols for receiving the required network parameters such as IP address and sub net mask.

The default IP settings of EtherNet/IP for the module are:

IP address: 192.168.250.xxx

Subnet Mask: 255.255.255.000

You can change the IP address by DHCP (section 4.1.1) or Webserver (section 4.1.2).

The following table describes the operating modes represented by the rotary code switch settings:

Rotary code switch Function

000

(EtherNet/IP)

Activate DHCP and BOOTP functions.

In this mode, IP addresses can be assigned through specialized

software such as Rockwell's built-in BOOTP-DHCP server and other

tools. Please refer to the example for explanation.

001~254

(EtherNet/IP)

The last three digits of an IP address.

In this mode, network information such as IP addresses can be

modified by accessing the Webserver module through a browser. Only

the first 9 digits can be set, and the last 3 digits are based on the rotary

switch.

If the module has already been assigned an IP address through DHCP

of 000, it needs to be reset using 999 before the IP address in this

mode can take effect.

255~299

(EtherNet/IP)

Illegal address, invalid setting.

The original network parameters of the module will not be changed.

300~399 The module runs under the PROFINET protocol and the IP address
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(Profinet) needs to be set through programming software (such as Portal).

400~654

(CC-Link IE FB)

The last three digits of an IP address.

In this mode, network information such as IP addresses can be

modified by accessing the Webserver module through a browser. Only

the first 9 digits can be set, and the last 3 digits are based on the rotary

switch.

700~799

(ModbusTCP)

The last three digits of an IP address.

In this mode, network information such as IP addresses can be

modified by accessing the Webserver module through a browser. Only

the first 9 digits can be set, and the last 3 digits are based on the rotary

switch.

800~899 Reserved multiple protocol switching related functions, please do not

select.

999 Module reset.

This mode needs to be maintained for more than 5 seconds after

power on, and when the module port indicator lights scroll and flash,

it indicates a successful reset.

This operation will clear network parameters such as module IP

address and restore to factory settings. Please operate with caution.

4.1.1 Setting IP through DHCP software (Code: 000)

When the rotary code switch is selected as 000, the FCEN-8LKM-8A-Mmodule allocates network parameters such as IP addresses and subnet masks

through DHCP software. This section takes the BOOTP-DCP server tool that comes with Rockwell software as an example to demonstrate how to

allocate IP addresses.

First open the BOOP-DHCP server, click on Tools->Network Settings to set the network parameters and fill in the Subnet Mask.
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Then the DHCP server will find current gateway that has no IP address assigned on the network, and then click the gateway MAC address that needs

to be assigned IP.

Then click Add to Relation List, or double-click MAC address, in the pop-up window, fill in IP address in IP bar, such as 192.168.1.108.

As follows:

Note: the assigned IP address needs to be in the same IP segment as the local computer.

After the assigned IP address appears in the IP Address column in the list, the IP address of the device is assigned successfully. As follows:
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After the IP address is assigned, the device can work normally on the network. However, if the device is powered off and restarted, the assigned IP

address will be lost. Follow the above steps to process IP address allocation. If the IP address to be distributed is solidified to the gateway and its

power-off IP address is not lost, you need to click the Disable BOOTP/DHCP button in the following figure. After the Command Successful appears in

the Status column, the IP address is successfully solidified. If you click the Status column and there is no success message, you need to click again until

the command succeeds. As follows:

Note: If the module has already been assigned an IP address and BOOTP/DHCP is disabled, it will not be able to be automatically searched. There

are two ways to reset the IP address.

1) You need to click the "New" button, manually add the MAC and original IP address of the module, and then click the "Enable DHCP" button.

Once successful, you can search for this module. Then close the software and power on the module again to assign a new IP.

2) In the event of a power outage, turn the rotary code back to 999 and then power on again for 5 seconds. Wait for the module port indicator light

to scroll and flash, then power off again and switch back to 000 to reassign.
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4.1.2 Setting IP through Webserver (Code: 001~254)

When the rotary code switch is selected from 001 to 254, the FCEN-8LKM-8A-Mmodule accesses the web server through a browser to allocate

network parameters such as IP addresses and subnet masks.

The default value of the module or after resetting through code 999, the default IP address is 192.168.250.xxx (depending on the rotary switch value).

When the computer and module IP addresses are in the same network segment, you can use a browser to enterhttp://192.168.250.xxx/webif/to

access the module and modify the first 9 digits of the IP address.

You can see the IP address setting interface on the homepage, modify the values of the IP address and subnet mask, and click the "Set IP" button.

After successful setup, "IP configuration successful" will display under the button, The prompt "effective after board reboot" indicates that the new IP

address will take effect after the power reboot.

http://192.168.250.xxx/webif
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4.2 Module address assignment

This section mainly introduces the signal point arrangement order and address assignment of the FCEN-8LKM-8A-Mmodule, mainly to indicate the

clear sequence of signals. Due to the different addressing methods in different PLC systems, this article explains them in Bytes, and systems in Word or

DWord units can be arranged in the same order.

The FCEN-8LKM-8A-M module supports multiple connection types such as Exclusive owner, Input only, Listen only, etc. By default, the Exclusive owner

type that supports input and output signals is used. The data size and instance encoding are shown in the table below:

Datasize InstanceID Length of data

INPUT 171 394 bytes

OUTPUT 160 260 bytes

CONFIG 102 100 bytes

The default connection name is "Control/Status+IOL32+Status", which includes the input and output signals and status indicators of the IO-Link master,

as well as 32 bytes of data input and output and IO-Link status information for each IO-Link port. There will be detailed descriptions in subsequent

chapters.
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4.3 INPUT data address assignment

The FCEN-8LKM-8A-M module occupies a total of 394 bytes (Bytes 0-393) of input data. The following table lists the mapping of input data occupied

by the IO-Link master and IO-Link slave respectively:

Byte Input data Description

0...7 Module status
Indicate the status of IO-Link master and

IO-Link port.

8...9 Input signal of Master
Process input data for IO-Link Master SIO

mode.

10…57 IO-Link Port 1 Process input data for Port 1.

58...105 IO-Link Port 2 Process input data for Port 2.

106...153 IO-Link Port 3 Process input data for Port 3.

154...201 IO-Link Port 4 Process input data for Port 4.

202...249 IO-Link Port 5 Process input data for Port 5.

250...297 IO-Link Port 6 Process input data for Port 6.

298…345 IO-Link Port 7 Process input data for Port 7.

346…393 IO-Link Port 8 Process input data for Port 8.

4.3.1 Status feedback of IO-Link master

This section consists of 8 bytes, used to represent the status and error information related to the IO-Link master.

INPUT Description

Byte 0 IO-Link Communication Status

Byte 1 IO-Link Device Diagnosis（Short-Circuit & Overload）

Byte 2 IO-Link Port Power Supply Short Circuit（Pin1&Pin3）

Byte 3 Reserved

Byte 4 IO-Link Port Output Overload (Pin4 or Pin2)

Byte 5 Power Supply Diagnosis

Byte 6 IO-Link Device Second Supply Voltage Fault

Byte 7 Reserved

For a detailed description of status feedback, please refer to the following:

Byte 0（IO-Link Communication Status）

When the port is configured in IO-Link mode and has established a connection with the IO-Link device, the corresponding point indicates 1;

otherwise, the point indicates 0.
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Byte 0 IO-Link Communication Status

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 1（IO-Link Device Diagnosis）

When there is a diagnostic alarm on the IO-Link slave device connected to the port (only supporting short circuit and overload detection of

IO-Link slaves), the corresponding point indicates 1, otherwise the point indicates 0.

Byte 1 IO-Link Device Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 2（IO-Link Port Power Supply Short Circuit）

When short circuit occurs between Pin1 and Pin3 of the IO-Link master port, the corresponding point indicates 1, otherwise the point indicates

0.

Byte 2 IO-Link Port Power Supply Short Circuit

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 4（IO-Link Port Output Overload）

When overload occurs between Pin4/Pin2 and Pin3 of the IO-Link master port, the corresponding point indicates 1, otherwise the point

indicates 0.

Byte 4 IO-Link Port Output Overload

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 5（Power Supply Diagnosis）

When there is an abnormality in the power supply of the IO-Link master, the corresponding point indication changes to 1, based on the fault

status of over voltage, under voltage, and disconnection of the voltage.

Otherwise, the point indication is 0.

Byte 5 Power Supply Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Ua_H
High

voltage

Ua_L
Low

voltage

Us_H
High

voltage

Us_L
Low

voltage

Ua_S
Short
circuit

- - -
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Byte 6（IO-Link Device Second Supply Voltage Fault）

When the IO-Link slave device connected to the port and experiences an auxiliary power loss alarm, the corresponding point indicates 1,

otherwise the point indicates 0.

Byte 6 IO-Link Device Second Supply Voltage Fault

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

4.3.2Input signal of IO-Link master

This section consists of 2 bytes, used to represent the status of the IO-Link master port when receiving switch signals.

The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of the first port is

arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.

Byte 8 Digital input status of port 1~4

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port4

Pin2

Port4

Pin4

Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Byte 9 Digital input status of port 5~8

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port8

Pin2

Port8

Pin4

Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

4.3.3Input signal and status feedback of IO-Link slave

This section consists of 384 bytes, with each IO-Link port occupying 48 bytes.

The front part of the 48 bytes of each port is the input signal of the IO-Link slave, and the back part is the status, encoding, events, etc. of the IO-Link

slave.

The following table shows the address assignment for 8 IO-Link ports.

Input Port Description

Byte 10…41 Port1 Byte 0~31 of IO-Link input signal data
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Byte 42…43 Port1 Byte 0~1 of IO-Link status

Byte 44…45 Port1 Byte 0~1 of Vendor_ID from IO-Link device

Byte 46…48 Port1 Byte 0~2 of Device_ID from IO-Link device

Byte 49…57 Port1 Byte 0~8 of IO-Link event

Byte 58…89 Port2 Byte 0~31 of IO-Link input signal data

Byte 90…91 Port2 Byte 0~1 of IO-Link status

Byte 92…93 Port2 Byte 0~1 of Vendor_ID from IO-Link device

Byte 94…96 Port2 Byte 0~2 of Device_ID from IO-Link device

Byte 97…105 Port2 Byte 0~8 of IO-Link event

Byte 106…137 Port3 Byte 0~31 of IO-Link input signal data

Byte 138…139 Port3 Byte 0~1 of IO-Link status

Byte 140…141 Port3 Byte 0~1 of Vendor_ID from IO-Link device

Byte 142…144 Port3 Byte 0~2 of Device_ID from IO-Link device

Byte 145…153 Port3 Byte 0~8 of IO-Link event

Byte 154…185 Port4 Byte 0~31 of IO-Link input signal data

Byte 186…187 Port4 Byte 0~1 of IO-Link status

Byte 188…189 Port4 Byte 0~1 of Vendor_ID from IO-Link device

Byte 190…192 Port4 Byte 0~2 of Device_ID from IO-Link device

Byte 193…201 Port4 Byte 0~8 of IO-Link event

Byte 202…233 Port5 Byte 0~31 of IO-Link input signal data

Byte 234…235 Port5 Byte 0~1 of IO-Link status

Byte 236…237 Port5 Byte 0~1 of Vendor_ID from IO-Link device

Byte 238…240 Port5 Byte 0~2 of Device_ID from IO-Link device

Byte 241…249 Port5 Byte 0~8 of IO-Link event

Byte 250…281 Port6 Byte 0~31 of IO-Link input signal data

Byte 282…283 Port6 Byte 0~1 of IO-Link status

Byte 284…285 Port6 Byte 0~1 of Vendor_ID from IO-Link device

Byte 286…288 Port6 Byte 0~2 of Device_ID from IO-Link device

Byte 289…297 Port6 Byte 0~8 of IO-Link event

Byte 298…329 Port7 Byte 0~31 of IO-Link input signal data

Byte 330…331 Port7 Byte 0~1 of IO-Link status

Byte 332…333 Port7 Byte 0~1 of Vendor_ID from IO-Link device

Byte 334…336 Port7 Byte 0~2 of Device_ID from IO-Link device

Byte 337…345 Port7 Byte 0~8 of IO-Link event
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Byte 346…377 Port8 Byte 0~31 of IO-Link input signal data

Byte 378…379 Port8 Byte 0~1 of IO-Link status

Byte 380…381 Port8 Byte 0~1 of Vendor_ID from IO-Link device

Byte 382…384 Port8 Byte 0~2 of Device_ID from IO-Link device

Byte 385…393 Port8 Byte 0~8 of IO-Link event

Taking Port1 port as an example, describe the meanings represented by Byte10~Byte57 in detail. The data definitions for other IO-Link ports can

be calculated according to the above table.

Byte 10…41（IO-Link input signal data）

This section is the signal data of the IO-Link slave device, with a total of 32 bytes. According to the IO-Link standard, the maximum data size of

a single IO-Link slave is 32 bytes. If the slave data is less than 32 bytes, it is arranged from the lowest byte of the data.

Byte 10…41 IO-Link input signal data

Byte 10 Byte 0 of IO-Link device input signal data

Byte 11 Byte 1 of IO-Link device input signal data

…… Byte 2~30 of IO-Link device input signal data

Byte 41 Byte 31 of IO-Link device input signal data

Byte 42…43（IO-Link status）

This section reflects the status of the IO-Link slave device connected to this IO-Link port. If the status matches the point description, the

corresponding point indicates 1; otherwise, the point indicates 0.

DC: Device connected

IOL: Port in IO-Link Mode

VF: Validation failed

SC: IO-Link short-circuit

DF: Data storage validation failed

PDI: Process data invalid

Byte 42 IO-Link Status

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean - - - - - - DC IOL

Byte 43 IO-Link Error

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0
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Mean SC - - - - PDI DF VF

Byte 44…45（Vendor_ID from IO-Link device）

This section contains the manufacturer's code for the IO-Link slave device,

totaling 2 bytes.

Byte 44…45 Vendor_ID from IO-Link device

Byte 44 Vendor_ID (High Byte) of device connected

Byte 45 Vendor_ID (Low Byte) of device connected

Byte 46…48（Device_ID from IO-Link device）

This section contains the device's code for the IO-Link slave device,

totaling 3 bytes.

Byte 46…48 Vendor_ID from IO-Link device

Byte 46 Device ID (High Byte) of device connected

Byte 47 Device ID (Mid Byte) of device connected

Byte 48 Device ID (Low Byte) of device connected

Byte 49…57（IO-Link Event）

This section is the status of the IO-Link slave device, which can record the last 3 events, with 3 bytes for each event, for a total of 9 bytes.

Mode: 0-Reserved; 1-Singal event; 2-Event outgoing; 3-Event incoming.

Type: 0-Reserved; 1-Message; 2-Warning; 3-Error.

The meaning represented by each byte is as follows:

Event_1

Byte 49 IOL EventQualifier1

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Mode Type -

Byte 50 IOL EventCode1(High Byte)

Byte 51 IOL EventCode1(Low Byte)

Event_2

Byte 52 IOL EventQualifier2

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Mode Type -

Byte 53 IOL EventCode2 (High Byte)
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Byte 54 IOL EventCode2 (Low Byte)

Event_3

Byte 55 IOL EventQualifier3

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Mode Type -

Byte 56 IOL EventCode3 (High Byte)

Byte 57 IOL EventCode3 (Low Byte)
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4.4 OUTPUT data address assignment

The FCEN-8LKM-8A-M module occupies a total of 260 bytes (Bytes 0-259) of output data. The following table lists the mapping of output data

occupied by the IO-Link master and IO-Link slave respectively:

Byte Output data Description

0...1 Module Control
Control the function (diagnosis or restart) of

IO-Link port.

2...3 Output signal of Master
Process output data for IO-Link Master SIO

mode.

4…35 IO-Link Port 1 Process output data for Port 1.

36…67 IO-Link Port 2 Process output data for Port 2.

68…99 IO-Link Port 3 Process output data for Port 3.

100…131 IO-Link Port 4 Process output data for Port 4.

132…163 IO-Link Port 5 Process output data for Port 5.

164…195 IO-Link Port 6 Process output data for Port 6.

196…227 IO-Link Port 7 Process output data for Port 7.

278…259 IO-Link Port 8 Process output data for Port 8.

4.4.1 Control function of IO-Link master

This section consists of 2 bytes, used to control the IO-Link master to disable port diagnosis or restart output, etc.

OUTPUT Description

Byte 0 Disable IO-Link Port Diagnosis

Byte 1 Reserved

For a detailed description of control function, please refer to the following:

Byte 0（Disable IO-Link Port Diagnosis）

When the port is configured in IO-Link mode and has established a connection with the IO-Link slave, if you want to disable the diagnosis on

this port, set the corresponding point to 1; otherwise, set the point to 0.

Byte 0 Disable IO-Link Port Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0
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Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 1（Reserved）

This byte is reserved for related functions and is currently useless.

Byte 1 Reserved

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

4.4.2 Output signal of IO-Link master

This section consists of 2 bytes, used to represent the output of the IO-Link master port when controlling switch signals.

The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of the first port is

arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.

Byte 2 Digital output status of port 1~4

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port4

Pin2

Port4

Pin4

Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Byte 3 Digital output status of port 5~8

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port8

Pin2

Port8

Pin4

Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

4.4.3Output signal of IO-Link slave

This section consists of 256 bytes, with each IO-Link port occupying 32 bytes. The 32 bytes of each port is the output signal of the IO-Link slave.

The following table shows the address assignment for 8 IO-Link ports.

Output Port Description

Byte 4…35 Port1 Byte 0~31 of IO-Link output signal data

Byte 36…67 Port2 Byte 0~31 of IO-Link output signal data

Byte 68…99 Port3 Byte 0~31 of IO-Link output signal data
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Byte 100…131 Port4 Byte 0~31 of IO-Link output signal data

Byte 132…163 Port5 Byte 0~31 of IO-Link output signal data

Byte 164…195 Port6 Byte 0~31 of IO-Link output signal data

Byte 196…227 Port7 Byte 0~31 of IO-Link output signal data

Byte 228…259 Port8 Byte 0~31 of IO-Link output signal data

Taking Port1 port as an example, describe the meanings represented by Byte4~Byte35 in detail. The data definitions for other IO-Link ports can be

calculated according to the above table.

Byte 4…35（IO-Link output signal data）

This section is the signal data of the IO-Link slave device, with a total of 32 bytes. According to the IO-Link standard, the maximum data size of

a single IO-Link slave is 32 bytes. If the slave data is less than 32 bytes, it is arranged from the lowest byte of the data.

Byte 4…35 IO-Link output signal data

Byte4 Byte 0 of IO-Link device output signal data

Byte 5 Byte 1 of IO-Link device output signal data

…… Byte 2~30 of IO-Link device output signal data

Byte 35 Byte 31 of IO-Link device output signal data
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4.5 CONFIG data address assignment

The FCEN-8LKM-8A-M module occupies a total of 100 bytes (Bytes 0-99) of config data. The following table lists the mapping of config data occupied

by the IO-Link master:

Byte Configdata Description

0…3 Module configuration General configuration for the overall module.

4…35 Port configuration Pin type and safe state configuration for ports.

36…43 IO-Link Port 1 Configuration for IO-Link Port 1.

44…51 IO-Link Port 2 Configuration for IO-Link Port 2.

52…59 IO-Link Port 3 Configuration for IO-Link Port 3.

60…67 IO-Link Port 4 Configuration for IO-Link Port 4.

68…75 IO-Link Port 5 Configuration for IO-Link Port 5.

76…83 IO-Link Port 6 Configuration for IO-Link Port 6.

84…91 IO-Link Port 7 Configuration for IO-Link Port 7.

92…99 IO-Link Port 8 Configuration for IO-Link Port 8.

4.5.1 General settings of IO-Link master

This section consists of 4 bytes, used to disable the diagnosis of IO-Link master and control the order of signal arrangement.

CONFIG Description

Byte 0 Disable Global Diagnosis

Byte 1 Disable Us Diagnosis

Byte 2 Disable Ua Diagnosis

Byte 3 Process Data Layout

For a detailed description of general settings, please refer to the following:

Byte 0（Disable Global Diagnosis）

This parameter is used to disable all diagnostics of the IO-Link master. When the point is set to 1, diagnosis is disabled, and when set to 0,

diagnosis is enabled.

When this setting is disabled, the uploaded diagnostic information and port indicator lights will no longer prompt any errors, but the status

transmitted through the input signal is not affected.

Byte 1（Disable Us Diagnosis）

This parameter is used to disable the system power supply diagnosis of the IO-Link master. When the point is set to 1, diagnosis is disabled,
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and when set to 0, diagnosis is enabled.

When this setting is disabled, the uploaded diagnostic information and port indicator lights will no longer prompt any errors, but the status

transmitted through the input signal is not affected.

Byte 2（Disable Ua Diagnosis）

This parameter is used to disable the output power supply diagnosis of the IO-Link master. When the point is set to 1, diagnosis is disabled,

and when set to 0, diagnosis is enabled.

When this setting is disabled, the uploaded diagnostic information and port indicator lights will no longer prompt any errors, but the status

transmitted through the input signal is not affected.

Byte 3（Process Data Layout）

This parameter is used to set the address mapping order of the IO-Link master switch input and output signals. The default value is 0, which is

arranged by port; It can also be set to 1, which is arranged according to the pins.

0-Portbased assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port1 Pin4 Not supported.

1 Port1 Pin2 Port1 Pin2

…… …… ……

6 Port4 Pin4 Not supported.

7 Port4 Pin2 Port4 Pin2

X+1 0 Port5 Pin4 Not supported.

1 Port5 Pin2 Port5 Pin2

…… …… ……

6 Port8 Pin4 Not supported.

7 Port8 Pin2 Port8 Pin2

1-Pin based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port1 Pin4 No supported.

1 Port2 Pin4 No supported.

…… …… ……

6 Port7 Pin4 No supported.

7 Port8 Pin4 No supported.

X+1 0 Port1 Pin2 Port1 Pin2

1 Port2 Pin2 Port2 Pin2

…… …… ……

6 Port7 Pin2 Port7 Pin2
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7 Port8 Pin2 Port8 Pin2

4.5.2 Port settings of IO-Link master

This section consists of 32 bytes, used to set the function of the IO-Link master ports Pin4 and Pin2, and the status of Pin2 output in case of network

disconnection or other abnormalities.

CONFIG Description

Byte 4…19 Pin4 type of Port 1~8

Byte 20…27 Pin2 type of Port 1~8

Byte 28…35 Pin2 safe state of Port 1~8

For a detailed description of port settings, please refer to the following:

Byte 4…19（Pin4 type of Port 1~8）

This section is used to set the properties of Pin4 in each port of the IO-Link master, which can control the IO-Link function of the enabled port.

Each port occupies 2 bytes of data, which is an INT variable. The default is 0, which means empty; Can be set to 1, means Input mode; Can be

configured to 32, means IO-Link mode.

Byte 4…19 Pin4 type of Port 1~8

Byte 4…5 Pin4 type of Port 1(0=empty, 1=DI, 32=IO-Link)

Byte6…7 Pin4 type of Port 2(0=empty, 1=DI, 32=IO-Link)

Byte8…9 Pin4 type of Port 3(0=empty, 1=DI, 32=IO-Link)

Byte10…11 Pin4 type of Port 4(0=empty, 1=DI, 32=IO-Link)

Byte12…13 Pin4 type of Port 5(0=empty, 1=DI, 32=IO-Link)

Byte 14…15 Pin4 type of Port 6(0=empty, 1=DI, 32=IO-Link)

Byte 16…17 Pin4 type of Port 7(0=empty, 1=DI, 32=IO-Link)

Byte18…19 Pin4 type of Port 8(0=empty, 1=DI, 32=IO-Link)

Byte 20…27（Pin2 type of Port 1~8）

This section is used to set the properties of Pin2in each port of the IO-Link master, which can be set as switch input or switch output.

Each port occupies 1 bytes of data, which is an SINT variable. The default is 0, which means Input mode; Can be set to 1, means Output mode;

Can be configured to 3, means Input/Output Universal.

Byte 20…27 Pin2 type of Port 1~8
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Byte 20 Pin2 type of Port 1(0=DI, 1=DO, 3=Universal)

Byte 21 Pin2 type of Port 2(0=DI, 1=DO, 3=Universal)

Byte 22 Pin2 type of Port 3(0=DI, 1=DO, 3=Universal)

Byte 23 Pin2 type of Port 4(0=DI, 1=DO, 3=Universal)

Byte 24 Pin2 type of Port 5(0=DI, 1=DO, 3=Universal)

Byte 25 Pin2 type of Port 6(0=DI, 1=DO, 3=Universal)

Byte 26 Pin2 type of Port 7(0=DI, 1=DO, 3=Universal)

Byte 27 Pin2 type of Port 8(0=DI, 1=DO, 3=Universal)

Byte 28…35（Pin2 safe state of Port 1~8）

This section is used to set the safety status of Pin2output in each port of the IO-Link master.When the IO-Link master experiences network

disconnection or other abnormalities, the Pin2 output signal will switch to the set value.

Each port occupies 1 bytes of data, which is an SINT variable. The default is 0, which means the output is turned off in case of an exception;

Can be set to 1, which means the output is turned on in case of an exception; It can be set to 2, which means the output will maintain the last

value in case of an exception.

Byte 28…35 Pin2 safe state of Port 1~8

Byte 28 Pin2 safe state of Port 1

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 29 Pin2 safe state of Port 2

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 30 Pin2 safe state of Port 3

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 31 Pin2 safe state of Port 4

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 32 Pin2 safe state of Port 5

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 33 Pin2 safe state of Port 6

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 34 Pin2 safe state of Port 7

(0=SetTo0, 1=SetTo1, 2=Hold Last)

Byte 35 Pin2 safe state of Port 8

(0=SetTo0, 1=SetTo1, 2=Hold Last)
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4.5.3 Parameter settings of IO-Link slave

This section consists of 64 bytes, with each IO-Link port occupying 8 bytes. The 8 bytes of each port include IO-Link cycle time setting, ISDU parameter

backup setting, IO-Link slave code setting, etc.

The following table shows the address assignment for 8 IO-Link ports.

CONFIG Port Description

Byte 36…37 Port1 IO-Link Port Cycle Time

Byte 38 Port1 IO-Link Port Validation and Backup

Byte 39…40 Port1 Byte 0~1 of Vendor_ID to IO-Link device

Byte 41…43 Port1 Byte 0~2 of Device_ID to IO-Link device

Byte 44…45 Port2 IO-Link Port Cycle Time

Byte 46 Port2 IO-Link Port Validation and Backup

Byte 47…48 Port2 Byte 0~1 of Vendor_ID to IO-Link device

Byte 49…51 Port2 Byte 0~2 of Device_ID to IO-Link device

Byte 52…53 Port3 IO-Link Port Cycle Time

Byte 54 Port3 IO-Link Port Validation and Backup

Byte 55…56 Port3 Byte 0~1 of Vendor_ID to IO-Link device

Byte 57…59 Port3 Byte 0~2 of Device_ID to IO-Link device

Byte 60…61 Port4 IO-Link Port Cycle Time

Byte 62 Port4 IO-Link Port Validation and Backup

Byte 63…64 Port4 Byte 0~1 of Vendor_ID to IO-Link device

Byte 65…67 Port4 Byte 0~2 of Device_ID to IO-Link device

Byte 68…69 Port5 IO-Link Port Cycle Time

Byte 70 Port5 IO-Link Port Validation and Backup

Byte 71…72 Port5 Byte 0~1 of Vendor_ID to IO-Link device

Byte 73…75 Port5 Byte 0~2 of Device_ID to IO-Link device

Byte 76…77 Port6 IO-Link Port Cycle Time

Byte 78 Port6 IO-Link Port Validation and Backup

Byte 79…80 Port6 Byte 0~1 of Vendor_ID to IO-Link device

Byte 81…83 Port6 Byte 0~2 of Device_ID to IO-Link device

Byte 84…85 Port7 IO-Link Port Cycle Time

Byte 86 Port7 IO-Link Port Validation and Backup

Byte 87…88 Port7 Byte 0~1 of Vendor_ID to IO-Link device

Byte 89…91 Port7 Byte 0~2 of Device_ID to IO-Link device
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Byte 92…93 Port8 IO-Link Port Cycle Time

Byte 94 Port8 IO-Link Port Validation and Backup

Byte 95…96 Port8 Byte 0~1 of Vendor_ID to IO-Link device

Byte 97…99 Port8 Byte 0~2 of Device_ID to IO-Link device

Taking Port1 port as an example, describe the meanings represented by Byte36~Byte43 in detail. The data definitions for other IO-Link ports can

be calculated according to the above table.

Byte 36…37（IO-Link Port Cycle Time）

This section is used to set the cycle time for IO-Link port communication. According to the IO-Link protocol specification, the cycle time is

determined by a combination of multiples and time benchmarks.

Each port occupies 2 bytes of data, which is an INT variable. For ease of use, the following table lists the corresponding setting values for

different cycle times. Users can directly enter Value in the INT variable to modify the corresponding Cycle time.

Byte 36…37 IO-Link Port Cycle Time (1.6ms~11.2ms)

Value (INT) 0 16 32 48 64 68 72 76

Cycle time

(ms)
Auto 1.6 3.2 4.8 6.4 8.0 9.6 11.2

IO-Link Port Cycle Time (12.8ms~24ms)

Value (INT) 80 84 88 92 96 100 104 108

Cycle time

(ms)
12.8 14.4 16.0 17.6 19.2 20.8 22.4 24.0

IO-Link Port Cycle Time (25.6ms~36.8ms)

Value (INT) 112 116 120 124 128 129 130 131

Cycle time

(ms)
25.6 27.2 28.8 30.4 32.0 33.6 35.2 36.8

IO-Link Port Cycle Time (38.4ms~49.6ms)

Value (INT) 132 133 134 135 136 137 138 139

Cycle time

(ms)
38.4 40.0 41.6 43.2 44.8 46.4 48.0 49.6

IO-Link Port Cycle Time (51.2ms~62.4ms)

Value (INT) 140 141 142 143 144 145 146 147

Cycle time

(ms)
51.2 52.8 54.4 56.0 57.6 59.2 60.8 62.4

IO-Link Port Cycle Time (64ms~75.2ms)
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Value (INT) 148 149 150 151 152 153 154 155

Cycle time

(ms)
64.0 65.6 67.2 68.8 70.4 72.0 736 75.2

IO-Link Port Cycle Time (76.8ms~88ms)

Value (INT) 156 157 158 159 160 161 162 163

Cycle time

(ms)
76.8 78.4 80.0 81.6 83.2 84.8 86.4 88.0

IO-Link Port Cycle Time (89.6ms~100.8ms)

Value (INT) 164 165 166 167 168 169 170 171

Cycle time

(ms)
89.6 91.2 92.8 94.4 96.0 97.6 99.2 100.8

IO-Link Port Cycle Time (102.4ms~113.6ms)

Value (INT) 172 173 174 175 176 177 178 179

Cycle time

(ms)
102.4 104.0 105.6 107.2 108.8 110.4 112.0 113.6

IO-Link Port Cycle Time (115.2ms~126.4ms)

Value (INT) 180 181 182 183 184 185 186 187

Cycle time

(ms)
115.2 116.8 118.4 120.0 121.6 123.2 124.8 126.4

IO-Link Port Cycle Time (128ms~132.8ms)

Value (INT) 188 189 190 191 - - - -

Cycle time

(ms)
128.0 129.6 131.2 132.8 - - - -

Byte 38（IO-Link Port Validation and Backup）

This section is used to set the verification and parameter storage function of the port. Depending on the type of setting, the port will verify

whether the connected IO-Link slave Vendor_ID and Device_ID are consistent with the set values, and perform backup and recovery of ISDU

parameters according to the settings. The default value is 0, which means no checksum storage is performed.

0---No Device check;

1---Type compatible Device V1.0;

2---Type compatible Device V1.1;

3---Type compatible Device V1.1, Backup + Restore;

4---Type compatible Device V1.1, Restore
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Byte 39…40（Vendor_ID from IO-Link device）

This section contains the manufacturer's code for the IO-Link slave device,

totaling 2 bytes.

Byte 39…40 Vendor_ID from IO-Link device

Byte 39 Vendor_ID (High Byte) of device connected

Byte 40 Vendor_ID (Low Byte) of device connected

Byte 41…43（Device_ID from IO-Link device）

This section contains the device's code for the IO-Link slave device,

totaling 3 bytes.

Byte 41…43 Vendor_ID from IO-Link device

Byte 41 Device ID (High Byte) of device connected

Byte 42 Device ID (Mid Byte) of device connected

Byte 43 Device ID (Low Byte) of device connected
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4.6 Configuration commissioning (AB PLC)

4.6.1 Installing EDS files

Use EDS files to configure the EtherNet/IP protocol IO-Link module, which is used to integrate the EtherNet/IP protocol module as a standard

EtherNet/IP slave into your system. You can visit the ELCO company website to obtain the latest EDS files or call the customer service hotline to

contact technical personnel.

The integration of EDS files into the system depends on the configuration software you are using. Typically, the Rockwell Studio5000 programming

software used for the EtherNet/IP protocol integrates EDS files according to the following steps:

1） Run “Logix Designer” software and select “TOOLS>EDS Hardware Installation Tool” in the menu bar.

2） In the open dialog box, select "Register an EDS file" to proceed to the next step, select the EDS file to be installed, and then click "Next" to

proceed with the installation operation.
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3） The newly installed IO-Link master module can be found when adding network devices and is displayed in the "New Module" interface.

By filtering the "Module Type Vendor Filter" and selecting "Elco (Tianjin) Electronic", this module can be found and added in the Catalog.

4.6.2 Configuration example in Logix Designer

This section provides users with a comprehensive understanding of the actual use of the IO-Link module in the EtherNet/IP protocol through a

configuration connection process. This example uses ELCO's FCEN-8LKM-8A-Mmodule as the EtherNet/IP slave to connect Rockwell's 1756-L71

controller and 1756-EN2TR network adapter. By default, all power supply and bus connections have been completed.

The EtherNet/IP protocol IO-Link system includes one IO-Link master module FCEN-8LKM-8A-M (with IP address 192.168.0.11 set in advance), with

expansion ports Port1 and Port6 connected to one IO-Link slave hub LKHA-16UP-M12G, and the remaining expansion ports set to the off state

We show the specific software configuration process in the form of pictures:

1) Create a new Studio5000 project.

A) Open the “Logix Designer” software and click "File>New...".
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B) In the pop-up interface, select the PLC type to use and click "Next".

C) Select PLC version, rack, slot number, etc., and click "Finish".

2) Add the 1756-EN2TR network module and set the IP address.

A) In the left Controller Organizer navigation bar, right-click on “1756-A4”, select “New Module...”, select “1756-EN2TR” in the open

interface, and click "Create".
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B) In the pop-up interface, fill in the IP address 192.168.0.5 of the module and provide the required name for the module, such as EN2TR.

Click "OK" to complete the network adapter configuration.
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3) Add the FCEN-8LKM-8A-Mmodule and set the IP address.

A) In the left Controller Organizer navigation bar, right-click on Ethernet under 1756-EN2TR, select "New Module...", filter ELCO in the

open interface, select module model FCEN-8LKM-8A-M, and click "Create".

B) In the pop-up interface, fill in the IP address 192.168.0.11 of the module and provide the required name for the module, such as FCEN.

Click "OK" to complete the configuration of the IO-Link module.
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4) After completing the configuration of the hardware module, it is necessary to map the ports and other parameters of the IO-Link module.

You can refer to Section 4.5 for the allocation of data addresses. Set the Port1 and Port6 ports to IO-Link mode, and set the values of

FCEN_M:C.Port1_Pin4_Type and FCEN_M:C.Port6_Pin4_Type to 32. At the same time, in order to provide output power to the IO-Link slave, set the

Pin2_Type of FCEN_M: C.Port1~8 to 3.

Note: If the value of the CONFIG parameter is modified after network connection, the IO-Link module must be powered on or connected back

to the network in order for the newly modified parameters to take effect.
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5) Select the already set connection in the RSlinx Classic. In this example, connect through the AB_ETHIP network and select the "Go Online"

button to switch the software to online mode. At the same time, a pop-up interface will pop up and select "Download" to download the program to

the PLC.

6) After completing the download operation, the NET light of FCEN-8LKM-8A-Mmodule will turn green, indicating that the EtherNet/IP

connection between the module and the PLC is successful. The input and output signals of the control module can be read and controlled through the

Controller Tags variable table or by programming.

7) Due to the absence of an IO-Link slave output auxiliary power supply signal, the Port1 and Port6 indicator lights of LKHA-16UP-M12G are

set to IO-Link mode and connected in red. It is necessary to refer to section 4.4 for module OUTPUT data address assignment, and set

FCEN_M:O1.Data[2].1 and FCEN_M:O1.Data[3].3 to 1. After a successful assignment, the light_00 remains yellow and light_01 remains green of Port1;
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the light_10 remains yellow and light_11 remains green of Port6.

8) All configuration work has been completed and can be used normally.
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4.6.3 Import Add-On Instruction

For the convenience of connecting the FCEN-8LKM-8A-Mmodule to AB PLC, ELCO provides an Add-On Instruction specifically designed for Logix

Designer software. This program block sorts and annotates the INPUT, OUTPUT, and CONFIG data of the FCEN-8LKM-8A-Mmodule. Users can easily

read and control module signals through the AOI program block.

This AOI function block is suitable for RSLogix5000 or Studio5000 software, and the hardware can adapt to various PLCs such as Compact Logix or

Control Logix. The usage steps are as follows:

1) Right click on the “Add-On Instructions” item in Controller Organizer, select "Import Add On Instructions...", and select the AOI-FCEN dedicated

to the ELCO FCEN-8LKM-8A-M module from the pop-up menu L5X file, click the "Open" button to import.

2) After successful import, you can see the newly imported function block under the Add-On Instructions category. At the same time, the Data

Types involved in the function block will also be imported together, which can be seen under the User-Defined category.
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3) You can see the newly imported blocks in the programming interface.

4) Insert the function block into the program by dragging or clicking, and fill in the corresponding variables according to the data type of the

Add-On Instruction. Among them, the variables corresponding to the newly inserted FCEN-8LKM-8A-M module need to be selected for

FCEN_Raw_Config, FCEN_Raw_Input_Data, and FCEN_Raw_Output_Data. Other projects require users to add variables according to the data type

themselves.
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5) The names and data types of AOI block variables are shown in the table below:

Parameter Name Description Data Type Tag Name
(User defined)

AOI_FCEN_M
Unique Control Tag for

AOI Module
AOI_FCEN_M Master_Control_Tag

FCEN_M_Raw_Config
Raw config data from

Module Defined Tags
SINT[100] Module_Name:C

FCEN_M_Raw_Input_Data Raw input data from

Module Defined Tags
SINT[394] Module_Name:I1.Data

FCEN_M_Raw_Output_Data Raw output data from

Module Defined Tags
SINT[260] Module_Name:O1.Data

FCEN_M_Port_1_Data
All I/O Data

with IO-Link Port 1

UDT_FCEN_M_
IO_Link_Port_Data Port1_Data

FCEN_M_Port_2_Data All I/O Data

with IO-Link Port 2

UDT_FCEN_M_
IO_Link_Port_Data Port2_Data

FCEN_M_Port_3_Data All I/O Data
with IO-Link Port 3

UDT_FCEN_M_
IO_Link_Port_Data Port3_Data

FCEN_M_Port_4_Data All I/O Data

with IO-Link Port 4

UDT_FCEN_M_
IO_Link_Port_Data Port4_Data

FCEN_M_Port_5_Data All I/O Data

with IO-Link Port 5

UDT_FCEN_M_
IO_Link_Port_Data Port5_Data

FCEN_M_Port_6_Data All I/O Data

with IO-Link Port 6

UDT_FCEN_M_
IO_Link_Port_Data Port6_Data

FCEN_M_Port_7_Data All I/O Data
with IO-Link Port 7

UDT_FCEN_M_
IO_Link_Port_Data Port7_Data

FCEN_M_Port_8_Data All I/O Data

with IO-Link Port 8

UDT_FCEN_M_
IO_Link_Port_Data Port8_Data

Mapped_FCEN_M_Data

All Unique data

associated with

FCEN-8LKM-8A-M

UDT_FCEN_M Mapped_Master_Data
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6) After completing the addition of the AOI block and downloading it to the PLC, the INPUT, OUTPUT and CONFIG variables of the

FCEN-8LKM-8A-Mmodule can be read and controlled through the Mapped_Master_Data variable. Due to the addition of this instruction, it is

necessary to read and write signal points in the “Parameters and Local Tags”. The values in the Controller Tags cannot be directly modified like in

steps 6 and 7 of section 4.6.2. At the same time, the signal points of the FCEN-8LKM-8A-Mmodule used in programming also need to directly call

the values in the Mapped_Master_Data variable.

Note: If the value of the CONFIG parameter is modified after network connection, the IO-Link module must be powered on or connected back

to the network in order for the newly modified parameters to take effect.

7) The INPUT,OUTPUT and CONFIG variables of the FCEN-8LKM-8A-M module have been classified and described in the AOI_FCEN program block.

For more detailed information, please refer to Chapter 4 “Module Signal Address Assignment”.
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5. PROFINET

5.1 Setting the network parameters

When the FCEN-8LKM-8A-Mmodule powered on, the module will read the rotary switch positions. If the rotary switch position stays 300~399, the

module will work in PROFINET protocol.

The factory default IP address is 0.0.0.0 and the default device name is empty. You can set them by the Siemens programming software Portal.

1） Run “TIA Portal” software and select “Project view” in the left side.

2） In the new window, Click "Online Access" in the "Project Tree" on the left, finding the name of the computer network card. Double-click

"Update accessible devices" and then the name and MAC address of the connected IO-Link master module will be scanned.

3） Double click the module you scanned, open the “Online & diagnostics” tab. Under the “Functions”, you can assign IP address and

PROFINET device name to the module.
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1) The “device name” will be used in the programming steps.

2) The “IP address” can be used for accessing the Webserver.
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5.2 Module address assignment

This section mainly introduces the signal point arrangement order and address assignment of the FCEN-8LKM-8A-Mmodule, mainly to indicate the

clear sequence of signals. This picture shows the I/O signal and status of the IO-Link master:

5.2.1 I/O signal of IO-Link master

This section consists of 2 bytes, used to represent the status of the IO-Link master port when receiving and controlling switch signals.

The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of the first port is

arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.

Byte 0 Digital input/output status of port 1~4

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 07 06 05 04 03 02 01 00

Pin Port4

Pin2

Port4

Pin4

Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

Byte 1 Digital input/output status of port 5~8

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

No. 15 14 13 12 11 10 09 08

Pin Port8

Pin2

Port8

Pin4

Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4
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5.2.2 Status feedback of IO-Link master

This section consists of 4 bytes, used to represent the status and error information related to the IO-Link master.Users can freely choose to configure

any item.

INPUT Description

Byte 2 IO-Link Communication Status

Byte 3 IO-Link Device Diagnosis（Short-Circuit&Overload）

Byte 4 Master Port Error（Short-Circuit&Overload）

Byte 5 Power Supply Diagnosis

For a detailed description of status feedback, please refer to the following:

Byte 2（IO-Link Communication Status）

When the port is configured in IO-Link mode and has established a connection with the IO-Link device, the corresponding point indicates 1;

otherwise, the point indicates 0.

Byte 2 IO-Link Communication Status

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 3（IO-Link Device Diagnosis）

When there is a diagnostic alarm on the IO-Link slave device connected to the port (only supporting short circuit and overload detection of

IO-Link slaves), the corresponding point indicates 1, otherwise the point indicates 0.

Byte 3 IO-Link Device Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 4（Master Port Error）

When short circuit occurs between Pin1 and Pin3 of the IO-Link master port or overload between Pin2 and Pin3 of the IO-Link master port,

the corresponding point indicates 1, otherwise the point indicates 0.

Byte 4 Master Port Error

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 5（Power Supply Diagnosis）

When there is an abnormality in the power supply of the IO-Link master, the corresponding point indication changes to 1, based on the fault

status of over voltage, under voltage, and disconnection of the voltage.
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Otherwise, the point indication is 0.

Byte 5 Power Supply Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Mean Ua_H
High

voltage

Ua_L
Low

voltage

Us_H
High

voltage

Us_L
Low

voltage

Ua_S
Short
circuit

- - -

5.2.3Control function of IO-Link master

This section consists of 1 bytes, used to control the IO-Link master to disable port diagnosis, Users can freely choose to configure the item.

OUTPUT Description

Byte 2 Disable IO-Link Port Diagnosis

Byte 2（Disable IO-Link Port Diagnosis）

When the port is configured in IO-Link mode and has established a connection with the IO-Link slave, if you want to disable the diagnosis on

this port, set the corresponding point to 1; otherwise, set the point to 0.

Byte 2 Disable IO-Link Port Diagnosis

Bit Bit_7 Bit_6 Bit_5 Bit_4 Bit_3 Bit_2 Bit_1 Bit_0

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1
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5.3 Setting parameters of the module

Users can set the parameters of the module in TIA Portal. Enter the "Device View" interface and select "Properties-> General-> Module Parameters" of

"IOLINK Master IO_1". Users can modify the module parameters as needed.

5.3.1 Global diagnostic settings

This section consists of 3items, used to disable the diagnosis of IO-Link master.For a detailed description of diagnostic settings, please refer to the

following:

Item_1（Global Diagnosis）

This parameter is used to disable all diagnostics of the IO-Link master. When the selection box is checked, diagnosis is enabled, and when the

selection box is not checked, diagnosis is disabled.

When this setting is not selected, the uploaded diagnostic information and port indicator lights will no longer prompt any errors, but the status

transmitted through the input signal is not affected.

Item_2（System Power Supply Diagnosis）

This parameter is used to disable the system power supply diagnosis of the IO-Link master. When the selection box is checked, diagnosis is

enabled, and when the selection box is not checked, diagnosis is disabled.
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When this setting is not selected, the uploaded diagnostic information and port indicator lights will no longer prompt any errors, but the status

transmitted through the input signal is not affected.

Item_3（Auxiliary Power Supply Diagnosis）

This parameter is used to disable the output power supply diagnosis of the IO-Link master. When the selection box is checked, diagnosis is

enabled, and when the selection box is not checked, diagnosis is disabled.

When this setting is not selected, the uploaded diagnostic information and port indicator lights will no longer prompt any errors, but the status

transmitted through the input signal is not affected.

5.3.2Port settings of IO-Link master

This section used to set the function of the IO-Link master ports Pin4 and Pin2, and the status of Pin2 output in case of network disconnection or

other abnormalities.

The Pin4 functions of the IO-Link port are configure as digital input. Users can change it to IO-Link mode by replacing the slots. The Pin2 functions can

be set to input or output or universal by selecting. For a detailed description of port settings, please refer to the following:

Item_1（Pin2 type of Port 1~8）

This section is used to set the properties of Pin2in each port of the IO-Link master, which can be set as switch input or switch output or

universal.

The default is “I/O Universal”, which means the Pin2 can be used as Input or Output by wiring; Can be set to “Input”, which means only as

Input; Can be set to “Output”, which means only as Output.

Item_2（Pin2 safe state of Port 1~8）

This section is used to set the safety status of Pin2output in each port of the IO-Link master.When the IO-Link master experiences network

disconnection or other abnormalities, the Pin2 output signal will switch to the set value.

The default is “0”, which means the output is turned off in case of an exception; Can be set to “1”, which means the output is turned on in case
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of an exception; Can be set to “Hold the last value”, which means the output will maintain the last value in case of an exception.

5.3.3 Process data layout

This parameter is used to set the address mapping order of the IO-Link master switch input and output signals. The default value is “Port base”, which

is arranged by port; It can also be set to “Pin base”, which is arranged according to the pins.

0-Portbased assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port1 Pin4 Not supported.

1 Port1 Pin2 Port1 Pin2

……

6 Port4 Pin4

7 Port4 Pin2 Port4 Pin2

X+1 0 Port5 Pin4 Not supported.

1 Port5 Pin2 Port5 Pin2

……

6 Port8 Pin4 Not supported.

7 Port8 Pin2 Port8 Pin2

1-Pin based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port1 Pin4 No supported.

1 Port2 Pin4 No supported.

……

6 Port7 Pin4 No supported.

7 Port8 Pin4 No supported.

X+1 0 Port1 Pin2 Port1 Pin2
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1 Port2 Pin2 Port2 Pin2

……

6 Port7 Pin2 Port7 Pin2

7 Port8 Pin2 Port8 Pin2
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5.4 Module configuration by Portal (Siemens PLC)

This section, through a case of connection configuration in a current operation process, will let the users fully understand how to use the

FCEN-8LKM-8A-Mmodule. In this case, using the FCEN-8LKM-8A-Mas PROFINET slave to connect the Siemens PROFINET controller CPU1511 under

the condition that all power and bus connections have been completed, the device name of IO-Link master module is assigned as elco67.

The Profinet protocol IO-Link system includes one IO-Link master module FCEN-8LKM-8A-M, with expansion ports Port1 connected to one IO-Link

slave hub LKHA-16UP-M12G, Port6 connected to LKHA-16UP-M12G-AP4, and the remaining expansion ports set to the off state

The following will show the specific process of software configuration and debugging.

1) Create a new Portal project

Open Portal software, click "Create New Project", change "Project Name" to"IO-link", select the save path, and click "Create".
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2) Install GSD files for the FCEN-8LKM-8A-Mmodule.

A) Select "Options"->"Manage General Station Description File (GSD)" in the menu bar.

B) Select the version of the GSD file to be imported and click ‘Install’.
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C) Double-click "Add New Device" on the left and select the PLC model in the "Controller" window.

D) Double-click the "Device Configuration" window on the left, and in the "Network View" window, select "Properties"->"PROFINET

Interface [X1]"->"Ethernet Address" and set the IP address of the PLC.



We reserve the right to make technical alterations without prior notice. EN Creation date: 17.12.25 | UM_AD_FCEN-8LKM-8A-M_V1.1
Page 67

FCEN-8LKM-8A-M MODULE MULTI PROTOCOL SYSTEMMANUAL
E) Add IO-Link master module and communicate with PLC

a) Double-click "Devices & Networks" on the left to enter the "Network View" interface and selectFCPN-8LKM-8A-M through "Other Field

Devices-> PROFINET IO-> I / O-> ELCO-> IOLink67 Master" in "Hardware Catalog", double-click or drag to add to the network.

b) Click the "Not assigned" hyperlink and click to select “PLC_1.PROFINET Interface_1”

c) The FCEN-8LKM-8A-M and PLC complete communication connection.
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F) Modify IO-Link master module device name and IP address settings

a) Click the IO-Link master module in the "Network View", select "Properties-> PROFINET Interface-> Ethernet Addresses", set the IO-Link

master module device name “elco67” in the window.

b) Click "Online Access" in the "Project Tree" on the left, find the name of the upper computer network card, double-click "Update

accessible devices", and then the name and MAC address of the connected IO-Link master module will be scanned. Double-click " Online

and Diagnostics ", modify the device name to elco67 in this interface.
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Note: The name of the IO-Link master module must be the same as the device name modified in the previous step.

G) Add the IO-Link sensor hub module to the Device Overview

a) Delete "Digital IN_1" in the "Device Overview" first.

b) Select "Module-> ELCO IO-Link Device Module-> LKHA-16UP-M12G" module in the "Hardware Catalog" window and drag it to the slot.



We reserve the right to make technical alterations without prior notice. EN Creation date: 17.12.25 | UM_AD_FCEN-8LKM-8A-M_V1.1
Page 70

FCEN-8LKM-8A-M MODULE MULTI PROTOCOL SYSTEMMANUAL
c) Repeat steps a and b to add a "LKHA-16UP-M12G-AP4" IO-Link signal hub module to the Port6 expansion port.

d) Users can add the Diagnostic Modules to the last 5 slots to read the module status and diagnosis in process data. You can double click or

drag the diagnostic module to the corresponding slot. Refer to section 5.2.2 for specific descriptions of the status.
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e) After saving and compiling, download the configuration to the PLC.

f) When the P1 and P6 expansion ports of the IO-Link master module are constantlyyellow and BF indicator is green on, the configuration is

successful.
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6.ModbusTCP

6.1 Setting the network parameters

When the FCEN-8LKM-8A-Mmodule powered on, themodule will read the rotary

Switch positions.If the rotary switch position stays 700~799, themodule will work inModbus-TCP protocol.

The factory default IP address is 192.168.0.10(rotary switch position stays 700).You can set them by the websever.eg: HTTP://192.168.0.10/webif/

1) Run “codesys” software and insert “Ethernet”in the left side, then insert ModbusTCP_Master, at the last insert Modbus-TCP_Slave.
2) Enter the IP address of the IO-Link master in the position shown in the figure below in CODESYS.

6.2 Add modbus slave channel

1） Click‘Modbus Slave Channel’ and ‘add channel’ button choose which function you want.You can find the addition of READ Offset andWRITE
Offset on websever
2） The figure below shows the data reading address of the process data displayed on the webserver.

0.0.0.0
0.0.0.0
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3) The figure below shows the process data and the data write address displayed on the webserver.

6.3 Configuration of Analog Module Parameters

1) Configuration of Analog Module Parameters

1.Select "SLOT INFO" on the web page.

2. Choose the master IO - Link port that is connected to the analog module.

3. Configure the word length for high-low byte flipping required for analog input and output. - For LKHA-08UA-M12G,

If all 8 channels are used as inputs, 10 words need to be configured (the first 8 words are for signals, and the following 2 words are for

diagnostic information). - For LKHA-08UA-M12G, if all 8 channels are used as outputs, 8 words need to be configured.

2) Use the web to select the IODD file of the analog module for channel configuration.
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After opening the corresponding analog module IODD file, select "Read All" to read all parameters. The parameters of the analog

channels can be configured. After modifying the parameters, click the corresponding "Write" button to write the parameters.

3) Analog module occupied word length

model
Input Output

INPUT(word) Diagnostic (word) OUTPUT(word)

LKHA-04UA-QC 4 2 4

LKHA-08UA-M12G 8 2 8

6.4 ModbusTCP slave I/O mapping

When you have completed the operation of adding channels, these added addresses will be displayed on the I/O mapping interface. You can add

variable tags to these addresses.In the demo program, the IO-Link master PORT2 is connected to the LKHA-16UP-M12 module. Here, the address

0x0011 is selected according to the previous table.
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The LKHA-16UP-M12 module has not only input process data but also output process data. Here, we have configured the output process data of this

module on port 2. According to the previous table, the address starts from 0x0811.

6.5 Module address assignment

This section mainly introduces the signal point arrangement order and address

assignment of theFCEN-8LKM-8A-Mmodule,Themain purpose is to clarify the address sequence of the signal points.
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1) This table shows the address distribution of reading process data:

2) This table shows the address distribution for writing process data:
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3) This table shows the address distribution of the diagnostic data:
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7. CC-Link IE Field Basic

7.1 Setting the network parameters

When the FCEN-8LKM-8A-Mmodule powered on, the module will read the rotary switch positions. If the rotary switch position stays 400~699, the

module will work in CC-Link IE Field Basic protocol.

The module supports the DHCP and BOOTP protocols for receiving the required networkparameters such as IP address and subnet mask.

The default IP settings of CC-Link IE Field Basic for the module are:

IP address: 192.168.3.xxx

Subnet Mask: 255.255.255.000

You can change the IP address by setting the rotary code switch or the web server.

The following table describes the operating modes represented by the rotary code switch settings:

Rotary code switch Function

000~299

(EtherNet/IP)

This module runs under the EtherNet/IP protocol. Please refer to the

previous section for setting the IP address.

300~399

(Profinet)

This module runs under the PROFINET protocol. Please refer to the

previous section for setting the IP address.

401~654

(CC-Link IE FB)

Subtract 400 from the value to obtain the last three digits of the IP

address. (i.e. 1-254)

In this mode, the Webserver module can be accessed through a

browser to modify network information such as IP addresses. Only the

first 9 digits can be set, and the last 3 digits are subject to the rotation

code.

Do not set the address to 400, otherwise the IP address may not be

successfully set.

655~699

(CC-Link IE FB)

Illegal address, invalid setting.

The original network parameters of the module will not be changed.

700~998 Reserved multiple protocol switching related functions, please do not

select.



We reserve the right to make technical alterations without prior notice. EN Creation date: 17.12.25 | UM_AD_FCEN-8LKM-8A-M_V1.1
Page 79

FCEN-8LKM-8A-M MODULE MULTI PROTOCOL SYSTEMMANUAL
999 Module reset.

This mode needs to be maintained for more than 5 seconds after

power on, and when the module port indicator lights scroll and flash,

it indicates a successful reset.

This operation will clear network parameters such as module IP

address and restore to factory settings. Please operate with caution.

When the rotary code switch is selected as 401~654, subtracting 400 from this value will result in the last 3 bits of the module IP address being 1~254.

Meanwhile, the FCEN-16UP-M12-M module can access the Webserver through a browser to allocate network parameters such as IP addresses and

subnet masks.

The default value of the module or after resetting through code 999, the default IP address is 192.168.3.xxx (depending on the rotary switch value

minus 400). When the computer and module IP addresses are in the same network segment, you can use a browser to

enterhttp://192.168.3.xxx/webif/to access the module and modify the first 9 digits of the IP address.

You can see the IP address setting interface on the homepage, modify the values of the IP address and subnet mask, and click the "Set IP" button.

After successful setup, "IP configuration successful" will display under the button, The prompt "effective after board reboot" indicates that the new IP

address will take effect after the power reboot.

http://192.168.3.xxx/webif
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7.2 Module address assignment

This section mainly introduces the signal point arrangement order and address allocation of the FCEN-8LKM-8A-Mmodule, which is used to clarify the

signal arrangement order. The signal points and status information of the IO-Link master occupy the RX and RY areas, while the input and output

signal data of the IO-Link slave device occupy the RWr and RWw areas.

Due to the fixed data length of the IO-Link master, it is necessary to determine the number of station addresses allocated by the IO-Link master in the

CC-Link IE FB network based on the data size of the configured IO-Link slave devices. According to the definition of CC-Link IE FB network, each site

contains 64 bits RX and RY, as well as 32 Words RWr and RWw.

When the data length of a single IO-Link slave device connected to a port is 1-16 bytes, the IO-Link master needs to occupy “2 Occupied Stations”

(default setting); When the data length of a single IO-Link slave device connected to a port is 17-24 bytes, the IO-Link master needs to occupy “3

Occupied Stations”; When the data length of a single IO-Link slave device connected to a port is 25-32 bytes, the IO-Link master needs to occupy “4

Occupied Stations”.These figures show the occupancy information of software components in the FCEN module:

2 Occupied Stations：

3 Occupied Stations：

4 Occupied Stations：
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7.3 RX and RY data address assignment

The FCEN-8LKM-8A-M module occupies different lengths of RX and RY data depending on the number of allocated station addresses. But the actual

effective number of RX and RY is the same (80 bits of RX and 32 bits of RY), with the rest being idle data.

The following table lists the data mapping of IO-Link master status information and signals occupancy, where each RX or RY represents a bit:

RX Input data Description

RX 00…3F Module status
Indicate the status of IO-Link master and

IO-Link port.

RX 40…4F Input signal of Master
Process input data for IO-Link Master SIO

mode.

RX 50…7F

(2 Stations)

RX 50…BF

(3 Stations)

RX 50…FF

(4 Stations)

Reserved Reserved

RY Output data Description

RY 00…0F Module Control
Control the function (diagnosis or restart) of

IO-Link port.

RY 10…1F Output signal of Master
Process output data for IO-Link Master SIO

mode.

RY 20…7F

(2 Stations)

RY 20…BF

(3 Stations)

RY 20…FF

(4 Stations)

Reserved Reserved
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7.3.1 Status feedback of IO-Link master

This section consists of 8 bytes, used to represent the status and error information related to the IO-Link master.

INPUT Description

RX 00…07 IO-Link Communication Status

RX 08…0F IO-Link Device Diagnosis（Short-Circuit&Overload）

RX 10…17 IO-Link Port Power Supply Short Circuit（Pin1&Pin3）

RX 18…1F Reserved

RX 20…27 IO-Link Port Output Overload (Pin4 or Pin2)

RX 28…2F Power Supply Diagnosis

RX 30…37 IO-Link Device Second Supply Voltage Fault

RX 38…3F Reserved

For a detailed description of status feedback, please refer to the following:

RX 00…07 (IO-Link Communication Status)

When the port is configured in IO-Link mode and has established a connection with the IO-Link device, the corresponding point indicates 1;

otherwise, the point indicates 0.

RX 00…07 IO-Link Communication Status

Bit RX07 RX06 RX05 RX04 RX03 RX02 RX01 RX00

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

RX 08…0F (IO-Link Device Diagnosis)

When there is a diagnostic alarm on the IO-Link slave device connected to the port (only supporting short circuit and overload detection of

IO-Link slaves), the corresponding point indicates 1, otherwise the point indicates 0.

RX 08…0F IO-Link Device Diagnosis

Bit RX0F RX0E RX0D RX0C RX0B RX0A RX09 RX08

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

RX 10…17 (IO-Link Port Power Supply Short Circuit)

When short circuit occurs between Pin1 and Pin3 of the IO-Link master port, the corresponding point indicates 1, otherwise the point indicates

0.

RX 10…17 IO-Link Port Power Supply Short Circuit

Bit RX17 RX16 RX15 RX14 RX13 RX12 RX11 RX10

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1
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RX 20…27 (IO-Link Port Output Overload)

When overload occurs between Pin4/Pin2 and Pin3 of the IO-Link master port, the corresponding point indicates 1, otherwise the point

indicates 0.

RX 20…27 IO-Link Port Output Overload

Bit RX27 RX26 RX25 RX24 RX23 RX22 RX21 RX20

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

RX 28…2F (Power Supply Diagnosis)

When there is an abnormality in the power supply of the IO-Link master, the corresponding point indication changes to 1, based on the fault

status of over voltage, under voltage, and disconnection of the voltage.

Otherwise, the point indication is 0.

RX 28…2F Power Supply Diagnosis

Bit RX2F RX2E RX2D RX2C RX2B RX2A RX29 RX28

Mean Ua_H
High

voltage

Ua_L
Low

voltage

Us_H
High

voltage

Us_L
Low

voltage

Ua_S
Short
circuit

- - -

RX 30…37（IO-Link Device Second Supply Voltage Fault）

When the IO-Link slave device connected to the port and experiences an auxiliary power loss alarm, the corresponding point indicates 1,

otherwise the point indicates 0.

RX 30…37 IO-Link Device Second Supply Voltage Fault

Bit RX37 RX36 RX35 RX34 RX33 RX32 RX31 RX30

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

7.3.2Input signal of IO-Link master

This section consists of 2 bytes, used to represent the status of the IO-Link master port when receiving switch signals.

The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of the first port is

arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.

RX 40…47 Digital input status of port 1~4

Bit RX47 RX46 RX45 RX44 RX43 RX42 RX41 RX40

No. 07 06 05 04 03 02 01 00

Pin Port4

Pin2

Port4

Pin4

Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4
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RX 48…4F Digital input status of port 5~8

Bit RX4F RX4E RX4D RX4C RX4B RX4A RX49 RX48

No. 15 14 13 12 11 10 09 08

Pin Port8

Pin2

Port8

Pin4

Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4

7.3.3 Control function of IO-Link master

This section consists of 2 bytes, used to control the IO-Link master to disable port diagnosis or restart output, etc.

OUTPUT Description

RY 00…07 Disable IO-Link Port Diagnosis

RY 08…0F Reserved

For a detailed description of control function, please refer to the following:

Byte 0（Disable IO-Link Port Diagnosis）

When the port is configured in IO-Link mode and has established a connection with the IO-Link slave, if you want to disable the diagnosis on

this port, set the corresponding point to 1; otherwise, set the point to 0.

RY 00…07 Disable IO-Link Port Diagnosis

Bit RY07 RY06 RY05 RY04 RY03 RY02 RY01 RY00

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

Byte 1（Reserved）

This byte is reserved for related functions and is currently useless.

RY 08…0F Restart output after short-circuit

Bit RY0F RY0E RY0D RY0C RY0B RY0A RY09 RY08

Port Port8 Port7 Port6 Port5 Port4 Port3 Port2 Port1

7.3.4 Output signal of IO-Link master

This section consists of 2 bytes, used to represent the output of the IO-Link master port when controlling switch signals.
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The default order of port signals is Port base, which means that the mapping addresses are arranged in port order. First, Pin4 of the first port is

arranged, then Pin2 of the first port, then Pin4 of the second port, and so on.

RY 10…17 Digital output status of port 1~4

Bit RY17 RY16 RY15 RY14 RY13 RY12 RY11 RY10

No. 07 06 05 04 03 02 01 00

Pin Port4

Pin2

Port4

Pin4

Port3

Pin2

Port3

Pin4

Port2

Pin2

Port2

Pin4

Port1

Pin2

Port1

Pin4

RY 18…1F Digital output status of port 5~8

Bit RY1F RY1E RY1D RY1C RY1B RY1A RY19 RY18

No. 15 14 13 12 11 10 09 08

Pin Port8

Pin2

Port8

Pin4

Port7

Pin2

Port7

Pin4

Port6

Pin2

Port6

Pin4

Port5

Pin2

Port5

Pin4
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7.4 RWr and RWw data address assignment

The FCEN-8LKM-8A-M module occupies different lengths of RWr and RWw data depending on the number of Occupied Stations. Meanwhile,

according to the different data size settings for each port (Each port size), the assignment of IO-Link slave address mapping is also different.

When Station_Config is Station2 (2x Occupied Station), ‘Each Port Size’ can be set to 1-16 bytes.

When Station_Config is Station3 (3x Occupied Station), ‘Each Port Size’ can be set to 17-24 bytes.

When Station_Config is Station4 (4x Occupied Station), ‘Each Port Size’ can be set to 25-32 bytes.

Note: The setting value of ‘Each Port Size’ depends on the IO-Link slave with the largest number of bytes connected to each IO-Link port. For

example, when there are multiple types of IO-Link slave devices such as 2-byte, 4-byte, 8-byte, etc., ‘Each Port Size’ should be filled with ‘8’.

The following table lists the data mapping of IO-Link slave devices for each port through several typical configurations, and other settings can be

calculated based on this. Each RWr and RWw represents a word (Word):

1) Set ‘2 Occupied Station’, with 2 bytes ‘Each Port Size’ (default configuration).

Input/Output data Description

RWr 00

RWw 00
IO-Link Port 1 Process input data for Port 1.

RWr 01

RWw 01
IO-Link Port 2 Process input data for Port 2.
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RWr 02

RWw 02
IO-Link Port 3 Process input data for Port 3.

RWr 03

RWw 03
IO-Link Port 4 Process input data for Port 4.

RWr 04

RWw 04
IO-Link Port 5 Process input data for Port 5.

RWr 05

RWw 05
IO-Link Port 6 Process input data for Port 6.

RWr 06

RWw 06
IO-Link Port 7 Process input data for Port 7.

RWr 07

RWw 07
IO-Link Port 8 Process input data for Port 8.

RWr 08…3F

RWw 08…3F
Reserved Reserved

2) Set ‘2 Occupied Station’, with 4 bytes ‘Each Port Size’.

Input/Output data Description

RWr 00…01

RWw 00…01
IO-Link Port 1 Process input data for Port 1.

RWr 02…03

RWw 02…03
IO-Link Port 2 Process input data for Port 2.

RWr 04…05

RWw 04…05
IO-Link Port 3 Process input data for Port 3.

RWr 06…07

RWw 06…07
IO-Link Port 4 Process input data for Port 4.

RWr 08…09

RWw 08…09
IO-Link Port 5 Process input data for Port 5.

RWr 0A…0B

RWw 0A…0B
IO-Link Port 6 Process input data for Port 6.

RWr 0C…0D

RWw 0C…0D
IO-Link Port 7 Process input data for Port 7.

RWr 0E…0F

RWw 0E…0F
IO-Link Port 8 Process input data for Port 8.
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RWr 10…3F

RWw 10…3F
Reserved Reserved

3) Set ‘2 Occupied Station’, with 16 bytes ‘Each Port Size’.

Input/Output data Description

RWr 00…07

RWw 00…07
IO-Link Port 1 Process input data for Port 1.

RWr 08…0F

RWw 08…0F
IO-Link Port 2 Process input data for Port 2.

RWr 10…17

RWw 10…17
IO-Link Port 3 Process input data for Port 3.

RWr 18…1F

RWw 18…1F
IO-Link Port 4 Process input data for Port 4.

RWr 20…27

RWw 20…27
IO-Link Port 5 Process input data for Port 5.

RWr 28…2F

RWw 28…2F
IO-Link Port 6 Process input data for Port 6.

RWr 30…37

RWw 30…37
IO-Link Port 7 Process input data for Port 7.

RWr 38…3F

RWw 38…3F
IO-Link Port 8 Process input data for Port 8.

4) Set ‘3Occupied Station’, with 24 bytes ‘Each Port Size’.

Input/Output data Description

RWr 00…0B

RWw 00…0B
IO-Link Port 1 Process input data for Port 1.

RWr 0C…17

RWw 0C…17
IO-Link Port 2 Process input data for Port 2.

RWr 18…23

RWw 18…23
IO-Link Port 3 Process input data for Port 3.

RWr 24…2F

RWw 24…2F
IO-Link Port 4 Process input data for Port 4.
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RWr 30…3B

RWw 30…3B
IO-Link Port 5 Process input data for Port 5.

RWr 3C…47

RWw 3C…47
IO-Link Port 6 Process input data for Port 6.

RWr 48…53

RWw 48…53
IO-Link Port 7 Process input data for Port 7.

RWr 54…5F

RWw 54…5F
IO-Link Port 8 Process input data for Port 8.

5) Set ‘4Occupied Station’, with 32 bytes ‘Each Port Size’. (Maximum)

Input/Output data Description

RWr 00…0F

RWw 00…0F
IO-Link Port 1 Process input data for Port 1.

RWr 10…1F

RWw 10…1F
IO-Link Port 2 Process input data for Port 2.

RWr 20…2F

RWw 20…2F
IO-Link Port 3 Process input data for Port 3.

RWr 30…3F

RWw 30…3F
IO-Link Port 4 Process input data for Port 4.

RWr 40…4F

RWw 40…4F
IO-Link Port 5 Process input data for Port 5.

RWr 50…5F

RWw 50…5F
IO-Link Port 6 Process input data for Port 6.

RWr 60…6F

RWw 60…6F
IO-Link Port 7 Process input data for Port 7.

RWr 70…7F

RWw 70…7F
IO-Link Port 8 Process input data for Port 8.

7.5 Setting parameters of the module

Users can set module parameters in GX Works3. Enter the "Ethernet Port" interface, select "Network Configuration Settings" from "CC-Link IEF Basic

Settings", and in the newly opened window, users can modify module parameters as needed.
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Right click on the module and select "Parameter Processing of Slave Station.." to open the settings interface.

In the newly opened window, you can see the parameter settings of the
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module.

7.5.1 Occupied Station Address Setting

This parameter Station_Config is used to set the station address multiplier of CC-Link IE FB occupied by the FCEN-8LKM-8A-Mmodule. The default

value is ‘Station2’, which is ‘2 Occupied Station’; It can also be set to ‘Station3’, which is ‘3 Occupied Station’; It can also be set to ‘Station4’, which is ‘4

Occupied Station’.

This setting depends on the data length of a single IO-Link slave connected to the IO-Link port. When the data length of a single IO-Link slave device

connected to a port is 1-16 bytes, the IO-Link master needs to occupy ‘2 Occupied Station’ (default setting); When the data length of a single IO-Link

slave device connected to a port is 17-24 bytes, the IO-Link master needs to occupy ‘3 Occupied Station’; When the data length of a single IO-Link

slave device connected to a port is 25-32 bytes, the IO-Link master needs to occupy ‘4 Occupied Station’.

7.5.2Each IO-Link Port Size

This parameter ‘Each Port Size’ is used to set the byte length occupied by each IO-Link port of the FCEN-8LKM-8A-Mmodule. The default value is ‘2’,

which means that each IO-Link slave device receives 2 bytes of INPUT and OUTPUT data; It can also be set to any value between ‘1-32’, that is, each

IO-Link slave device Input and OUTPUT data from 1-32 bytes.
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7.5.3 Process Data Layout

This parameter is used to set the address mapping order of the I/O module switch input and output signals. The default value is 0, which is arranged

by port; It can also be set to 1, which is arranged according to the pins.

0-Port based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port1 Pin4 Port1 Pin4

1 Port1 Pin2 Port1 Pin2

…… …… ……

6 Port4 Pin4 Port4 Pin4

7 Port4 Pin2 Port4 Pin2

X+1 0 Port5 Pin4 Port5 Pin4

1 Port5 Pin2 Port5 Pin2

…… …… ……

6 Port8 Pin4 Port8 Pin4

7 Port8 Pin2 Port8 Pin2

1-Pin based assignment.

Byte offset bit PD_IN PD_OUT

X 0 Port1 Pin4 Port1 Pin4

1 Port2 Pin4 Port2 Pin4

…… …… ……

6 Port7 Pin4 Port7 Pin4

7 Port8 Pin4 Port8 Pin4

X+1 0 Port1 Pin2 Port1 Pin2

1 Port2 Pin2 Port2 Pin2

…… …… ……

6 Port7 Pin2 Port7 Pin2

7 Port8 Pin2 Port8 Pin2
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7.5.4 Port settings of IO-Link master

This section used to set the function of the IO-Link master ports Pin4 and Pin2, and the status of Pin2 output in case of network disconnection or

other abnormalities.

For a detailed description of port settings, please refer to the following:

Item_1 (Pin4 type of Port 1~8)

This section is used to set the properties of Pin4in each port of the IO-Link master, which can be set as switch input or IO-Link mode.

The default is “Digital IN”, which means the Pin4 can be used as Input by wiring; Can be set to “IOL_I/O_0x/0x Byte”, which means as IO-Link

mode. Can connect IO-Link devices, where '0x/0x Byte' means the byte length of the IO-Link device.

Item_2（Pin2 type of Port 1~8）

This section is used to set the properties of Pin2in each port of the IO-Link master, which can be set as switch input or switch output or

universal.

The default is “I/O Universal”, which means the Pin2 can be used as Input or Output by wiring; Can be set to “Digital Input”, which means only

as Input; Can be set to “Digital Output”, which means only as Output.

Item_3（Pin2 safe state of Port 1~8）

This section is used to set the safety status of Pin2output in each port of the IO-Link master.When the IO-Link master experiences network

disconnection or other abnormalities, the Pin2 output signal will switch to the set value.
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The default is “Clear”, which means the output is turned off in case of an exception; Can be set to “Out_Set”, which means the output is

turned on in case of an exception; Can be set to “Hold the last value”, which means the output will maintain the last value in case of an

exception.
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7.6 Module configuration by MELSOFT (Mitsubishi PLC)

This section provides users with a comprehensive understanding of how to use the FCEN-8LKM-8A-Mmodule through a practical operation process of

configuring connections. With all power and bus connections completed, use FCEN-8LKM-8A-M as the CC-Link IE Field Basic slave to connect the

Mitsubishi controller FX5U, where the IP address of the I/O module is specified as 192.168.3.11. This IO-Link system includes one IO-Link Master

FCCB-8LKM-8A-M, with the expansion port P1 connected to one IO-Link hub LKHA-1600P-M12, and the expansion port P5 connected to one IO-Link

hub LKHA-16UP-M12.

The following will show the specific process of software configuration and debugging.

a. Install CSPP configuration file for FCEN-8LKM-8A-Mmodule

A) Select "Tool" ->"Profile Management" ->"Register..." in the menu bar, and click to open a new window.

B) Select the version of the CSPP file to import and click “Register”.

b. Create a new GXWorks3 project

Open the MELSOFT software, click "Project>New...", select the PLC series "FX5CPU" and model "FX5U" in the pop-up dialog box, choose the

programming language according to your habits, and then click "OK" to create the project.
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c. After entering the interface, select the "Navigation" project tree on the left side, and then choose "Parameter>Module

Parameter>Ethernet Port" to enter the network settings interface.

d. In the newly opened window, set the IP address of the PLC to "192.168.3.250" and the subnet mask to "255.255.255.0". Users can also

set according to their own needs, please note that the PLC and module need to be on the same IP network segment.



We reserve the right to make technical alterations without prior notice. EN Creation date: 17.12.25 | UM_AD_FCEN-8LKM-8A-M_V1.1
Page 99

FCEN-8LKM-8A-M MODULE MULTI PROTOCOL SYSTEMMANUAL
e. Enable CC Link IE Field Basic network settings, click on the "To Use or Not to use CIB Setting" option, and select "Use" to enable

network settings.

f. Perform CC Link IE Field Basic network configuration settings.

A) Click the button on the right side of "Network Configuration Settings" or double-click the text to open the "Detailed Setting" option.

B) In the newly opened "CC-Link IE FB Configuration" window, click the "Detect Now" button to automatically scan the FCENmodule

connected to the PLC, as shown in the figure.

C) Here you can see the IP address and other network information of FCEN-8LKM-8A-M. Please confirm the correspondence between the

IP address and the module MAC address.

D) Right click on the FCEN-8LKM-8A-M module and select "Parameter Processing of Slave Station..." under the "Online" option to enter the

module parameter settings page.
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E) In the newly opened parameter settings window, you can select "Parameter Read" and click the "Execute" button to read the set

parameters in modules that have already been connected to the network.

F) If you want to change the module parameters, you can select "Parameter Write", click "Cancel All Selections" to cancel all selections and

check the parameters that need to be changed. After setting, click the "Execute" button to write the module parameters that you want to

change.
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G) After setting up, click the "Close with Reflecting the Setting" button to save the content of network configuration and close the

interface.

g. Set up CC Link IE Field Basic network refresh and mapping.

A) Click the button to the right of “Refresh Settings” or double-click the text to open the “Detailed Setting” option.
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B) In the newly opened "Setting Item" interface, assign mapping addresses for RX, RY, RWr, and RWw in the PLC as needed, and then click

the "Apply" button as shown in the figure.
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8) At this point, the network settings have been completed and the program can be downloaded to the PLC. Select "Online>Write to PLC..." to

open the download window, choose "Select All" and click the "Execute" button to execute the download.

9) When the NET indicator light of FCEN-8LKM-8A-Mmodule is green and constantly on, it indicates that the configuration is successful and

the module has established communication connection with the PLC.
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8. Webserver

The FCEN-8LKM-8A-M module integrates Webserver internally. Users can access the Webserver through the IP address, set the parameters of the

module, read and write input and output signals, and set the ISDU parameters of the IO-Link device. (When the module is connected to the PLC, only

the IO signal status can be read and ISDU of IO-Link device can be set.)

In order to access the Webserver of the module, users need to first assign an IP address to the module. The method of assigning an IP address can be

referred by rotary switch or programming software. Then using the latest version of Chrome, Edge, or Safari browser, enter HTTP://xxx. xxx. xxx.

xxx/webif/ to access the module. (xxx. xxx. xxx. xxx is the IP address assigned by the module)

In this example, the IP of FCEN-8LKM-8A-Mmodule has been pre assigned to 192.168.0.11. Without connecting to the PLC, Port1 is connected to the

BNI007Z module of Balluff. Show how to enable port IO-Link function and allocate port properties of the Balluff module by importing an IODD file.

1) Set the IP address of the computer to 192.168.0.xxx on the same network segment as the FCEN-8LKM-8A-M module. Then open the browser

and enter in the address bar http://192.168.0.11/webif/ . You can see the homepage of the module Webserver.

http://192.168.0.11/webif


We reserve the right to make technical alterations without prior notice. EN Creation date: 17.12.25 | UM_AD_FCEN-8LKM-8A-M_V1.1
Page 105

FCEN-8LKM-8A-M MODULE MULTI PROTOCOL SYSTEMMANUAL
2) Click on the “SLOT CONFIG” item to enter the Ports Configuration interface, where you can read or set the port properties of 8 IO-Link

interfaces.

Set PIN4 of PORT1 to IO-Link and click the "Set Ports" button to make the modification effective.

3) After successful modification, it can be seen that Port1 automatically searches for the connected IO-Link device.

4) You can directly click on the IO-Link device found in the search, or select port Port1 through the “SLOT INFO” item to enter the details page of

the IO-Link port. Basic information such as device ID, transmission rate, and process data length of the IO-Link device can be read.
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5) “Force Outputs” are used to force Pin2 output to the IO-Link master port, achieving the goal of enabling auxiliary power supply to the IO-Link

slave. At the same time, the output value of the IO-Link slave can be written in the “Pin4 Output” interface.Click “Write” button to make it

effective.

6) Users can directly use the ISDU column on the page to define the parameters of the IO-Link slave to be modified through Index and Subindex,

and then read or write values in Data.
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7) Users can also visually edit the ISDU parameters of IO-Link slave by importing IO-Link device IODD files. Click the "Choose File" button to

import the prepared IODD file. Once successful, you can see the ISDU parameters of the IO-Link slave.
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8) You can obtain all the current ISDU values of IO-Link slave by clicking the "Read All" button, but a large number of parameters can result in a

long reading time. It is recommended to read and write the corresponding ISDU parameters through the “Read” or “Write” button corresponding

to each parameter.

9) After each parameter, there will be corresponding colored dots to represent the status of this parameter. No dots represent offline values,

green dots represent newly written values, and yellow dots represent read values.

Note: The operation of modifying ISDU parameters of the IO-Link slave through Webserver can be carried out with the FCEN-8LKM-8A-M

module connected to the PLC normally.
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9. Alarm diagnosis

9.1 LED fault indicator

With the LED indicator on the FCEN-8LKM-8A-M module, users can easily and quickly determine the current working status of the module. (For the

appearance of the indicator, please refer to Section 2.5 "LED Indication Function")

Name Status Meaning Fault cause

Expansion

channel

Indicator

IO-Link

Yellow IO-Link connection OK –

Green Ordinary digital signal –

Yellow flash No IO-Link connection Check the IO-Link cable connection

Red
1. Short circuit

2. Output signal overload

1. Check the cable connection

2.Module channel is damaged

Red flash IO-Link connection incorrect
1. Check the configuration

2.Check IO-Link device status

Gateway

status

Indicator

MOD

Green Work normally –

Red Working abnormally

1. Power supply is abnormal

2.Channel abnormal (short circuit, overload, etc.)

3. Module is damaged

Comm. status

Indicator NET

Green Communication normal –

Red Communication abnormal

1. Network cable failure

2. Check the configuration

3. Module is damaged

Network

status

Indicator Lk1,

2

Green
Network Cable connects

normal.
–

Off Network cable connects error.
1. Network cable failure

2. Module is damaged

Comm. data

Indicator

ACT1,2

Yellow flash Data exchange. -

Off No data exchange.
1. Check the configuration

2. Check the network hardware

Power supply

Indicator Us,

Ua

Green Supply voltage normal –

Red Supply voltage abnormal
1. Over voltage or undervoltage

2. Module is damaged

Off No power supply
1.Power supply cable failure

2. Module is damaged
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9.2 EtherNet/IP address assignment

The default connection name for the FCEN-8LKM-8A-M module is “Control/Status+IOL32+Status”. This connection contains the input and output

signals and status of the IO-Link master, as well as 32 bytes of data input and output and IO-Link slave status information for each IO-Link port.It

contains 394 bytes of INPUT, 260 bytes of OUTPUT, and 100 bytes of CONFIG. The table below lists the various data classifications, which can be found

in Chapter 4 for details.

Byte Input data Description

0...7 Module status Indicate the status of IO-Link master and IO-Link port.

8...9 Input signal of Master Process input data for IO-Link Master SIO mode.

10…57 IO-Link Port 1 Process input data for Port 1.

58...105 IO-Link Port 2 Process input data for Port 2.

106...153 IO-Link Port 3 Process input data for Port 3.

154...201 IO-Link Port 4 Process input data for Port 4.

202...249 IO-Link Port 5 Process input data for Port 5.

250...297 IO-Link Port 6 Process input data for Port 6.

298…345 IO-Link Port 7 Process input data for Port 7.

346…393 IO-Link Port 8 Process input data for Port 8.

Byte Output data Description

0...1 Module Control Control the function (diagnosis or restart) of IO-Link port.

2...3 Output signal of Master Process output data for IO-Link Master SIO mode.

4…35 IO-Link Port 1 Process output data for Port 1.

36…67 IO-Link Port 2 Process output data for Port 2.

68…99 IO-Link Port 3 Process output data for Port 3.

100…131 IO-Link Port 4 Process output data for Port 4.

132…163 IO-Link Port 5 Process output data for Port 5.

164…195 IO-Link Port 6 Process output data for Port 6.

196…227 IO-Link Port 7 Process output data for Port 7.

278…259 IO-Link Port 8 Process output data for Port 8.

Byte Configdata Description

0…3 Module configuration General configuration for the overall module.

4…35 Port configuration Pin type and safe state configuration for ports.

36…43 IO-Link Port 1 Configuration for IO-Link Port 1.

44…51 IO-Link Port 2 Configuration for IO-Link Port 2.

52…59 IO-Link Port 3 Configuration for IO-Link Port 3.
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60…67 IO-Link Port 4 Configuration for IO-Link Port 4.

68…75 IO-Link Port 5 Configuration for IO-Link Port 5.

76…83 IO-Link Port 6 Configuration for IO-Link Port 6.

84…91 IO-Link Port 7 Configuration for IO-Link Port 7.

92…99 IO-Link Port 8 Configuration for IO-Link Port 8.
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9.3 PROFINET address assignment

This section mainly introduces the signal point arrangement order and address assignment of the FCEN-8LKM-8A-Mmodule, mainly to indicate the

clear sequence of signals. This picture shows the I/O signal and status of the IO-Link master:
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9.4 CC-Link IE FB address assignment

This section mainly introduces the signal point arrangement order and address allocation of the FCEN-8LKM-8A-Mmodule, which is used to clarify the

signal arrangement order. The signal points and status information of the IO-Link master occupy the RX and RY areas, while the input and output

signal data of the IO-Link slave device occupy the RWr and RWw areas.

Due to the fixed data length of the IO-Link master, it is necessary to determine the number of station addresses allocated by the IO-Link master in the

CC-Link IE FB network based on the data size of the configured IO-Link slave devices. According to the definition of CC-Link IE FB network, each site

contains 64 bits RX and RY, as well as 32 Words RWr and RWw.

When the data length of a single IO-Link slave device connected to a port is 1-16 bytes, the IO-Link master needs to occupy “2 Occupied Stations”

(default setting); When the data length of a single IO-Link slave device connected to a port is 17-24 bytes, the IO-Link master needs to occupy “3

Occupied Stations”; When the data length of a single IO-Link slave device connected to a port is 25-32 bytes, the IO-Link master needs to occupy “4

Occupied Stations”.These figures show the occupancy information of software components in the FCEN module:

2 Occupied Stations：

3 Occupied Stations：

4 Occupied Stations：
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